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Reporting In SQL Server Reporting Services Report 
Designer 
In this document we have provided screen shots and examples of how it is possible to create a report for 
Attainment Manager processing. In these examples we have used the previous Key Stage Manager 
terminology and used KSM instead of Attainment Manager simply for the sake of brevity. In this context the 
terms are synonymous. 

Interaction and Architecture 
The Report Designer is accessible through the Microsoft Business Intelligence Development Studio toolkit, 
available from the SQL Server 2008 installation disk. Users with a license to access SQL Server 2008 have a 
license to install and use the Business Intelligence Development Studio. 

The Report Designer tool is intended for non-trivial reports which can use more than one Data Source (i.e. 
Database). The report designs generated from this toolkit are developed locally and uploaded to the Report 
Server once the designer has completed the reports. Practically any report layout and design can be achieved 
using this tool. 

Designing a Report – Attainment Manager 

Database Access and Data Models 
We do not recommend that the report designer is given access to the Oracle databases at the heart of the One 
system directly but should use the same data model that is available to users of the Report Builder. To create 
reports using this data source, start the Business Intelligence Development Studio and start and new Report 
Server Project. This will create a folder structure on your hard disk to work within. This project will contain a 
number of different files all of which combine to make a working report. 

The purpose of this worked example is to illustrate the method used to create a report based on the 
Attainment Project focus. We begin by creating the project: 
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This is re-written as: 

 
Once the OK button is selected the project should be created: 

The initial project will be empty as shown below. The first task is to link it to the desired report server so that 
reports designed in the toolkit can be published. Right-clicking and select the Properties menu option on the 
Report project (called here “KSM_Reporting_Project” in bold). 

 
Setting the publication properties: 

 
Note that the ‘TargetServerURL’ is blank.  
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It is necessary to add the TargetServerURL in order to deploy any subsequently raised reports. For instance: 

 
The TargetServerURL is the location of the One Report Server. 

Adding a Shared Data Source 
In order to use the published Report Model to access the underlying data, you must add a new Shared Data 
Source – this need only be done once for all the reports you design. The settings for this data source should be 
similar to that shown here. 

The user should right-click on the Shared Data Source and Select ‘Add New Data Source’. The following is 
displayed: 

 
Rename DataSource1 to KSM_DataSource, then select ‘Report Server Model’ from the ‘Type:’ drop down list. 
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In the ‘Connection string:’ text box type: 

server=http://XP5405/reportserver;datasource=/Report Models/Capita One Live Attainment Data 
Model 

In the example shown above XP5405 is the name of the server, this will need to be replaced with the relevant 
server name. Next select the credentials tab. Failure to do so will results in the warning: 

 
From the options provided the user should select the authentication requirement according to the needs of 
the organisation. 

Notes: 
The Type of the data source should be Report Server Model and the connection string is structured as follows; 

Server=http://W2K35318/reportserver;datasource=/Models/Capita One Live Attainment Data 

• Server=http:// - this is a required prefix (it may be https depending on your configuration). 

• W2K35318 - this is the name of your CCS Report Server. 

• Reportserver;datasource=/ - this is a required prefix. 

• Models – this is the folder on the report server where your models are stored  

• Capita One Live Attainment Data – this is the name of the report model you wish to use. 

Adding a Report 
You are now ready to create a report. Next, select the Reports option: 

 
The user should right-click on ‘Reports’ and select ‘Add Item’. Avoid using the option ‘Add New Report’ as this 
initiates the Report Wizard and requires the user to insert a select query. Instead, select ‘Add’ | ‘New Item’ 
and select ‘Report’. 
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Change the name to ‘KSM_Report’ as per the illustration below: 

 
 

The user should now select ‘Add’, the system now displays: 

 
The Solution Explorer now lists the new (empty) report within the Reports folder. Next, the dataset must be 
defined. The screen now displays a central area comprising three tabs, Data, Layout and Preview. The Data tab 
should be active and requires the user to create a query or in our case to link to the datasource. In this case 
the user should now select the Dataset Option and <New Dataset…>: 
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Once selected the system displays the following: 

 
Provide a suitable name for the dataset, such as KSM_DataSet. The data source value is already populated; so 
this should be left.  

For the ‘Command Type’ leave the option as set ‘Text’. 

 
Select Ok.  
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The system will return the following: 

 
 

Within the data tab the system now displays the available entities from which the user must make data 
selections. Scroll down from the list of entities until the entity ‘VIEW KSM RESULT ALL’ is found: 

From the list of fields available it is necessary to select the fields that will 
provide the data for the required report. 

 

The user should drag the required fields into the central area. The first 
selection should be ‘Project Name’. Once this is selected the list of 
entities reduces. From the ‘Base’ entity select the ‘Name’. From the 
‘Stud’ entity select the ‘Full Name’ field. Next, select the Aspect Name 
field from the ‘Aspect’ entity. Return to the VIEW KSM RESULT ALL and 
next select two fields: RESULT and VALIDATED. 

 

On completion of the field selection the display should be as displayed 
below: 

 
 

 

 

 

 

It is then necessary to select the Run icon: ‘!’ 



Creating Attainment Manager Reports Spring 2013 

Capita One 8 

Once the system has returned the data the screen should be as follows: 

 
The system has accessed the relevant data and it is now possible to design the report format. Next, select the 
layout tab.  

Layout 
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From the Toolbox select a ‘Table’ report item; drag the item across to the white grid: 

 
 

Select the far right column and then right-click, next select the option to Insert Column to the Right, repeat this 
process until you have six columns, (re-size the column widths if you prefer). 

 
 

Next, select the Dataset option from the left-hand panel (Ctrl + Alt + D). The system should display the 
following: 

For each of the fields from PROJECT_NAME to VALIDATED drag the field to 
the detail row of each respective column. As you do so the system will insert 
the correct syntax for the field and provide a title in the Header row. 
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At this point the user may select the Preview tab; the report should look something like: 

 
Return to the layout tab. 

Grouping the Data 
The next phase of the report creation is to consider grouping aspects. In our example it is relatively easy to 
consider that the next stage is to group the aspects, results and validation by the student. However, this 
approach is problematic; instead the first stage is to group the data by the project.  

Select the detail row by the row handler: 

This should select the detail row. Next, the user should right-click and select ‘Insert 
Group’. This will display the Properties pane for newly-created group. Rename the ‘Name’ 
box to KSM_Project_Group. In the Expression column select 
=Fields!PROJECT_NAME.Value. Then select OK. Move the =Fields!PROJECT_NAME.Value 
from the detail row to Group Header Row, thus: 
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The data is now grouped by the project. Repeat the process for the Base Name by returning to the detail row, 
right-click the row handle and select Insert Group. Complete the Grouping and Sorting Properties box as 
follows: 

 
 

Once again cut and paste the =Fields!BASE_NAME.Value field as follows: 

 
The data should preview as: 
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Next, repeat the process for the Full Name: 

 
 

Move the Full Name field to the Group Row (3) 

 
 

The report should now look like this: 

 
You may at this stage wish to add formatting and other facilities prior to publication. 

Formatting the Report 
From the toolbox select a textbox and drag the textbox to an appropriate size, insert the text ‘KSM Manager 
Report’: 
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Right click the textbox and select properties. 

This displays the following:  

 
 

Select the font tab and alter the font size to 20pt. If you wish to alter the font colour then select the Properties 
Window (F4) and select the ‘Color’ drop-down. 

 
 

The user may amend the colour for the font and background as required. Repeat this for any additional fields 
such as the project and base name or the rows should you prefer. 

 
For the Full_Name value field you may decide that the colour should depend on whether or not the results are 
complete. For instance, you may wish to see the student’s name displayed in a green font if all the results are 
present and red if any or all of the results are missing. In this case it is necessary to select an expression for the 
‘color’ property. 
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In the Layout tab select the Full_Name textbox and select the ‘Color’ drop-down text box. Next, select the 
‘Expression’ option. The system then displays the following: 

 
Type in the following: 

=iif(Count(Fields!ASPECT_Aspect_Name.Value)- Count(Fields!RESULT.Value) > 0 ,"Red”, “Green") 

This formula counts the number of aspects and then subtracts the number of results. If there are results 
missing, the student name is displayed in red otherwise, it is displayed in green. 

This can be used again for the Aspect Name textbox: 

=iif(Fields!RESULT.Value is nothing, "Red", "Green") 

In this case if the result is missing the aspect code is displayed in red, otherwise it is displayed in green:  
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Toggling Data Display 
The presentation of a report can be aided by the ability to toggle data. Simply expressed this is the ability to 
hide rows of data until the user wishes to view particular projects, schools or students. This is achieved by 
returning to the Layout tab. Select the BASE_Name textbox and then ensure the Properties Box is displayed: 

 
Select the Visibility attribute and set the ‘Hidden’ value to False and the ‘ToggleItem’ to ‘PROJECT_NAME’. 

Next, select the row handler for the details row. Select the Visibility attribute and set ‘Hidden’ to ‘True’ and the 
‘ToggleItem’ to ‘Full_Name’. 

Select the row handler for the Full_Name value. Select the Visibility – Hidden attribute and set this to ‘True’, 
set the ToggleItem to ‘BASE_Name’. 

Tidying the Report 
Remove empty row by deleting them after selection, these are mostly the group footers. You may also wish to 
colour to the report body. Select any part of the report other than the table or other text boxes. In the 
‘Properties’ panel select a suitable background colour for the report. 

 
This is the example report layout. 
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When the report is viewed through the Preview facility it looks like this: 

 
The user can toggle data by selecting the plus or minus icons: 
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Publishing 
When you have previewed your report you can publish it to the server. Right click on the Report Project name 
and select the Deploy option – this will publish the report to the report server and make it available to users 
based on the folder permissions it has been published to. 

The report published in the Report Designer to the report server will be visible within the One Rich Client and 
through the browser interface identically to a report published through Report Builder. Click-through reporting 
will switch between the two types of reports seamlessly. 

 
Once deployed the report may be viewed through a standard browser. 
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